
Software Application 
Tutorial 

 

Copyright 2007, Software Application Training Unit, West Chester University.  No Portion of 
this document may be reproduced without the written permission of the authors. 

For Assistance Call x3350 
 

A Member of the Pennsylvania State System of Higher Education 
 

 
 
 
 



TABLE OF CONTENTS 
 
Introduction.......................................................................................................... 2 
 
Creating a PDF file ................................................................................................ 3 
 
Create a PDF within Microsoft Application ............................................................. 3 
 
Microsoft Outlook XP and 2003............................................................................. 4 
 
Adobe PDF Printer................................................................................................. 5 
 
Creating a PDF from Multiple Files......................................................................... 5 
 
Create a PDF from a Web Page .............................................................................. 8 
 
Create a PDF by Dragging and Dropping ............................................................... 9 
 
Edit Document Properties...................................................................................... 9 
 
Useful Tools in the Acrobat Toolbar ...................................................................... 10 
 
Organizer ............................................................................................................. 11 
 
Comment and Markup .......................................................................................... 13 
 
Attach an Email Review ......................................................................................... 16 
 
Basic..................................................................................................................... 19 
 
Headers and Footers ............................................................................................. 20 
 
Watermarks and Backgrounds ............................................................................... 21 
 
Automatically Scroll .............................................................................................. 22 
 
Read Out Loud...................................................................................................... 22 
 
Bookmarks............................................................................................................ 23 
 
Working with Thumbnails ..................................................................................... 27 
 
Check Boxes ......................................................................................................... 31 
 
Text Fields............................................................................................................ 33 
 
Enabling Usage Rights in Adobe Reader ................................................................ 35

 1



Introduction 
 
 
Adobe Acrobat 8.0 Standard enables professionals to quickly and easily 
convert any document, including those from Microsoft Office and Internet 
Explorer, to Adobe Portable Document Format (PDF).  Adobe PDF files, 
which preserve the visual integrity of original documents, can be reliably e-
mailed to colleagues and customers. Acrobat 8.0 Standard’s intuitive 
review-management tools streamline communications and reduce the costs 
and inefficiencies associated with paper-based reviews.  PDF is Cross 
Platform, Navigational, Ultra-Printable, Ultra-Viewable and Smaller than 
other conventional document formats.  

 
 

Cross Platform: cross-platform indicates that the documents are 
independent of the software, hardware, and the operating system 
that were used to create the file. In simple words, you can read a 
PDF document in Windows that was created on a Macintosh that 
you downloaded from a web site running UNIX.  

 
Navigational: items built into the PDF file format allow the 
creators and the recipients to see the usefulness of the document.  
Internal and external links, bookmarks, thumbnails of each page, 
article threads, form fields, buttons for navigation, notes to 
annotate information and views to allow the user to magnify or 
reduce a page to fit within the user's computer screen.  

 
Ultra-Printable: PDF files are based on the PostScript language 
imaging model. This enables sharp, color-precise printing on 
almost all printers supported by the university.  

 
Ultra-Viewable: On screen PDF files have a precise color match 
regardless of the monitor used. PDF files allow the user to magnify 
documents up to 800% without the loss of clarity in text or 
graphics.  

 
Smaller: PDF files can be optimized to reduce their file sizes. PDF 
files can be 1/5 of the size of their HTML counterparts. 
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Creating a PDF file 
 
A PDF file can be created from a file (such as a Word document, Excel 
spreadsheet, PowerPoint file, etc.), multiple files and from a webpage. 
 
This can be accomplished in two different ways; by accessing the File pull- 
down menu or clicking on the Create PDF button located on the toolbar. 
 
File pull-down menu: 

 
 
 
Create PDF button: 

 
 

1. Click on the File pull-down menu or click on the Create PDF button. 
2. Select From File. 
3. The Open dialog box will appear. 
4. Select the file and click Open. 
5. Adobe will begin creating the file in PDF format.  Note the larger the 

file the longer it will take to create the PDF. 
6. When the file has been created it will automatically open in Adobe. 

 
Create a PDF from within a Microsoft Application 
 
1. Open the application. 
2. Open the document you want to change into a PDF:  in Microsoft 

Word, Excel and PowerPoint you will see the following toolbar after 
you install Adobe 8.0 Professional. If you do not see the toolbar go to 
the View pull-down menu rest your mouse on Toolbars and select 
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Acrobat PDFMaker 8.0 from the bottom of the list. 
 

    

   
Click on this button to convert your Microsoft Office file into a 
PDF. 

 
 

1. Click on the Convert your Word, Excel, etc. file to a PDF button. 
2. A “Save Adobe PDF File As” box will appear. 
3. Type in the file name and click Save. 
4. The following box will appear: 

 

 
 

5. Once this has finished the document will open in Adobe Acrobat. 
 

 

 

   

This button will convert your document into a PDF file and 
open an e-mail with this document included as an attachment. 

 
 
 
    
 
Microsoft Outlook XP and 2003 
 

1. Open a new e-mail message. 
2. On the Standard toolbar you will see the following button: 

 

 
 

3. Click on this button to attach a Word, Excel or PowerPoint document 
as a PDF. 

4. A Choose file dialog box will open. 
5. Select your file and click on Open. 
6. It will convert the file to a PDF document and attach it to the e-mail. 
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Adobe PDF Printer 
 
You can also create a PDF file by using the Adobe PDF printer driver. 
 

1. Open a file you would like to convert into a PDF document. 
2. Go to File, select Print. 
3. Select the Adobe PDF printer. 
4. Click OK. 

 

 
 

5. Your document will automatically convert into a PDF file and open in 
Adobe Acrobat. 
 

Creating a PDF from Multiple files 
 

1. Open Adobe Acrobat 8.0. 
2. Select the File pull-down menu, Create PDF and click on select from 

Multiple Files. 
3. Click on the Add Files button to add files you want to combine. 
4. Select the files you want to combine and click the Add button. To 

choose multiple files, hold down the Crtl key and click on the file to 
select it. Once you have added all the files you want to combine into 
one PDF document they will be listed in the “Arrange the files…" 
section as illustrated below. 
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5. You can change the order in which you would like the documents to 
appear in the PDF file by clicking once on the file name to highlight it 
and clicking on either the Move Up or down arrow buttons. 

6. Click the Add Open PDF icon to append any currently open PDF 
documents with the selected files.   

7. Click the Reuse Files icon to reuse a selected file in a combination file.  
This would be a file from a PDF that was created using multiple files. 

8. Click Next.  A Choose the type of combined PDF file to create window 
opens. 
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9. The Merge Files into a single PDF option is selected, this is the 
default.  Click Create. 

10. When the Conversion process is complete a Combine Files Complete 
window opens.  Click Save. 
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11. Acrobat converts the selected files into a single PDF document and 
displays the Save As dialog box.  The default name for the new 
document is Binder followed by a number.  The first document is 
Binder1.pdf, the next Binder2.pdf, and so on.  You can enter a 
different filename if you wish. 

12. Each of the files will open and then combine into one single PDF file. 
 

Create a PDF from a Web Page 
 
1. From the File pull-down menu, select Create PDF or click on the 

Create PDF button, select From Web Page.  The following dialog box 
will open. 
 

 
 

2. If the command has been used before, the last site opened is listed in 
the URL field.  Enter the URL you wish to convert to a PDF. 

3. If you want to open a single HTML page, accept the default settings 
options.  If you want to open the entire site in PDF format, choose the 
Get Entire Site option. 

4. Click browse, and Acrobat opens the Select File to Open dialog box. 
5. Navigate to the HTML file you want to convert to PDF format and then 

click Open.  If you chose the Get Entire Site option, select the home 
page of the site. 

6. Click Create.  If you chose the Get Entire Site option, Acrobat displays 
a dialog box warning you of a potentially large download.  Click Yes 
to begin the download; click No to abort.  When you use this 
command to convert HTML documents stored in a folder on your hard 
drive, the conversion to PDF is relatively quick.  However, when you 
download sites from the Web, the download time depends upon the 
quality of your connection, your modem speed, your processor, and 
the size and complexity of the web site. 
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Create a PDF by Dragging-and-Dropping 
 
You can launch Acrobat and create a PDF file by dragging a supported file 
format onto the Acrobat shortcut on your desktop.  This method comes in 
handy when you are working in other applications and need to add an 
accompanying PDF file to the file you are currently working on. 
 

1. Select the file you want to open as a PDF document.  You can select 
one or several files to open. 

2. Drag the selected file to the Acrobat desktop shortcut and release the 
mouse button.  After you release the mouse button, the shortcut icon 
dims out prior to the application launching, which signifies that the 
file has been correctly dropped on the icon.  Acrobat launches and 
converts the selected file to PDF format.  If you attempt to open a file 
that is not supported, Acrobat displays a warning dialog box. 

3. You can also drag-and-drop a file from a file folder directly into the 
Acrobat application.  If you select several files to open as PDF 
documents using this method, Acrobat creates a separate PDF file for 
each file you select. 
 

Edit Document Properties 
 
After you save a file in PDF format Acrobat uses the default Document 
Properties.  You can however change the properties before saving the 
document or edit them after the document is saved.  Some items that you may 
want to modify would be what the viewer sees when the document is opened 
or perhaps the security limits. 
 

1. In an open PDF document choose File, Properties to open the 
Document Properties dialog box. 

2. Click the Description tab (shown below) and modify the information in 
any of the following text fields:  Titles, Author, Subject and Keywords.  
Note this information is the first information viewers see concerning 
the document.  It is important to keep this information as relative as 
possible especially if the Search command is used to locate the 
information. 
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3. Click the Security tab to set document security options such as to 
password-protect a document or prevent users from printing the 
document. 

4. The Font tab displays information about the fonts embedded in the 
document. 

5. Click Initial View tab to set viewing options when the document is 
opened. 
 

Useful Tools in the Acrobat Toolbar 
 
Acrobat 8.0 has many useful tools and toolbars that are easily accessible by 
clicking the View pull-down menu, selecting Toolbars and clicking on the 
toolbar of your choice.  You can float these toolbars if they are items you use 
frequently or you can dock them in the Command bar by clicking, dragging 
and dropping it onto the bar. 
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Organizer 
The Organizer stores thumbnail images of every PDF document you’ve opened 
even if it is no longer present on your system.  You can locate documents that 
were opened during a specific time frame by clicking one of the History icons 
in the left pane of the Organizer.  To access the Organizer click on the File pull 
down menu, select Organizer and click on Open Organizer.  The following 
window will appear. 
 

 
 

1. Click the History icon in the left pane to display the documents 
opened during that period. 

2. Click a document title to select the document.  A thumbnail version of 
the first document page appears in the right pane of the Organizer. 

3. To open the selected document click the Open icon or double click 
the document title. 

4. After opening the document you can do one of the following: 
- Print 
- Email 
- Create PDF From Multiple Files 
- Send For Review (choose one of the options from the drop-down 

menu to send the current document for review) 
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Create PDF Collections using the Organizer 
The Acrobat Organizer can be used to create a collection of PDF documents.  
This is a great and convenient way to organize similar documents that appear 
in different folders on your computer.  After you create a collection it will 
appear as an icon in the Collections tree on the left side of the Organizer. 
 

1. Click the Create Collection icon in the lower-left corner of the 
Organizer.   

 

 
 

 
2. The default name of the new collection is Untitled followed by the 

next available number.  Right click the new collection and choose 
Rename Collection, rename the collection. 

3. Right click the collection and choose Add Files from the menu.  Click 
on Select Files To Add To Your Collection dialog box. 
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4. Browse to the folder that contains the desired files and select the 
ones you would like to add to your collection.  Click Add. 

5. Repeat step 4 to add to the collection any files that are stored in 
different folders. 

6. To open a collection launch the Organizer and double-click the 
desired collection title. 

7. To delete a collection right click the title and choose Delete 
Collection. 

 
Comment and Markup 
 
Comments can be added to any PDF document.  This is a very handy way to 
communicate between colleagues and clients.  Comments can be added by 
selecting the Comment and Markup tab or clicking on the Comment and 
Markup drop-down menu.  These notes are similar to yellow sticky notes.  If 
the PDF document is part of a review you can display all of the changes by 
selecting Show the Comments List from the Comment and Markup drop-down 
menu. 
 

1. Click on Comments and Markup.  Notice how the toolbar appears in 
the body of your document.  This is referred to as a floating toolbar.  
Left click on the top of the toolbar and drag it anywhere in the 
document.  This is a great feature if you perform the same task 
numerous times. 
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2. The Commenting toolbar is used to add a note, edit text, add a 
stamp, highlight and attach a file or record an audio comment. 

3. Click on the Sticky Note tool, a small icon resembling a sheet of paper 
with black lines on two sides will appear.  Drag this icon to where you 
would like to attach a note (see below).  Type your note in the box.  If 
you would like to close the box click on  in the upper right corner.  

To open the Sticky note click on  . 
 

 
 

 
4. To use the Text Edits tool, first highlight the text you would like to 

edit and then click on the drop-down arrow of the Text Edits button 
and select the tool you would like to use (see below). 

 

 
 

5. Click on Stamp Tool and select a stamp from a list of preformatted 
stamps.  The categories are; Dynamic, Sign Here and Standard 
Business.  Click on the stamp of your choice to activate it and drag it 
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to where you would like it to appear in your document. 
 

 
 

6. Click on the Highlight drop-down menu and select the tool you would 
like to use by clicking on it.  You will see an icon appear.  Highlight 
the text that you would like to change using the icon.  Notice the 
highlight on the third bullet. 

 

 
 
 

7. If you click on the Review and Comment drop-down menu there are 
several toolbar choices you can select from.  The tools provide you 
with more options to edit your PDF document and allows you to 
attach it to an email for review. 

8. Select Show Comments List from the Review and Comment pull down 
menu to view a list of all the comments made to this document.  The 
Comments tab lists the title of each comment, the page number on 
which the comment can be found and the author.  Comments are 
referred to by their icon types and attachments are referred to by 
their filename and extensions. 
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Attach an Email Review 
 

1. Click on the Review and Comment drop-down menu and select Attach 
for Email Review.  An Identity Setup window will appear, fill in all the 
information and then click Complete. 
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2. A Send Email for Review step by step window appears.  This window 

gives an explanation for how this process works.  In this window you 
will select the file you would like to send for review.  The file that you 
currently have open will appear in the Browse window.  Click Next. 

 

 
 

3. Invite Reviewers window is next, here is where you enter the email 
addresses.  You can select names from the Address Book.  Click Next. 
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4. A Preview Invitation widow opens.  A subject line and message body 
has already been added for you.  The message body gives detailed 
instructions on what the user should do with the document.  You can 
change the subject line or the message body is you so wish.  Click 
Send Invitation. 

 

 
5. An Outgoing Message Notification window will appear to notify you 

that the message has been sent.  Click Ok. 
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Basic 
 
The tools in this toolbar are used to manually navigate to different parts of a 
document and activate links within the file.  The tools are also used for 
selecting text and graphic elements for use in other applications. 
     

1. Click the Hand icon  to select it.  When you click inside the 
document to navigate with this tool it becomes a closed fist. 
- To navigate from top to bottom and vice versa move the tool over 

the document while holding down the left mouse button. 
- Release the left mouse button to stop scrolling the page. 
- This Hand tool is also used to find and activate links within the 

document.  When you pass your cursor over a bookmark in the 
bookmark tab it becomes a pointing finger. 

 
2. The Select tool  allows you to select text, tables or images in a PDF 

document and copy them to the clipboard for use in other 
applications. 
- Click on the Select tool icon and in the document select the text 

that you would like to copy to the clipboard.  Right click on the 
highlighted text and a menu will appear with several editing 
options.  Click on the option of your choice. 

 

 
 

3. The Snapshot tool is used to select an area of the document that can 
be pasted to the clipboard for use in another PDF document or 
application. 
- Click on the Tools drop down-menu, go to Select and Zoom and 

click on the Snapshot Tool.  Drag the cursor into the document.  
An icon will appear in the shape of intersecting dotted lines. 

- Move the mouse to the edge of the area that you would like to 
copy. 

- Hold down the left mouse button and drag diagonally.  As you 
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drag diagonally a dashed box appears to indicate the area of 
selection.  Release the button when the box encompasses the area 
you want to copy to the clipboard.  The following dialog box 
appears. 

 
- Click Ok to copy the selection.  You can click the checkbox next to 

Do not show this message again for this box to stop popping up 
each time you use this tool. 

 
Headers and Footers 
 
Acrobat 8.0 makes it very easy to add Headers and Footers to a document.  
The Header and Footer window is very user friendly by allowing you to 
customize the header and footer in one window. 
 

1. Go to the Document pull-down menu located on the toolbar, select 
Headers and Footers and click on Add.  Within this window you can 
select the Font, insert page numbers and a date.  You can view 
exactly how the header and footer will appear in the document in the 
preview section of the window.   When finished click OK. 
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Watermarks and Background 
 
Watermarks can be added to your document to make it look more professional.  
You can create your own watermark and specify features such as opacity and 
rotation. 
 

1. Click on the Document pull-down menu located on the toolbar and 
select either Background or Watermark and click Add. 

2. A thumbnail of the document appears in the upper right hand side of 
the window. 

3. Choose from the various options in the window to set the watermark.  
For example font, color, appearance and page range are a few of the 
many options you can use to customize your watermark. 
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Automatically Scroll 
 
The Automatically Scroll feature allows you to scroll through your PDF file 
without using the scrolling toolbar or the scroll button on your mouse. 

1. Go to the View pull-down menu located on the toolbar. 
2. Select Automatically Scroll.  As soon as you select this option your 

document will begin to scroll. 
3. To turn off the scrolling simply click on Automatically Scroll to 

uncheck it. 
 
 
Read Out Loud 
 
The Read Out Loud function will read your PDF file out loud using the default 
voice of the computer.  If you would like to change the voice go to the Control 
Panel, select Speech and then click on the Text to Speech tab to select the 
voice. 

1. Click on the View pull-down menu and select Read Out Loud from the 
list.  You can select to Read This Page Only or Read To End of 
Document. 

2. To turn the speech off go back to the View pull down menu and click 
on Stop. 

 

 
 

3. You can also select single sentences or phrases to be read only by 
highlighting the area.  
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Bookmarks 
 
When a PDF document is created with an authoring application, such as 
Microsoft Word, bookmarks are created automatically.  If the word document 
you used to create a PDF file contains Heading styles a bookmark appears for 
every heading style used in the document.  However if you created a PDF 
document using the Word Print command and choose Adobe PDF printer, no 
bookmarks are created.  If the document was created from a web page then 
the bookmark will navigate you to a specific web page.  To navigate to a 
bookmark within a document click the name in the Bookmarks tab of the 
Navigation pane. 
 
 
Bookmarks Tab Toolbar 
 
The bookmark toolbar can be used to create, edit and delete bookmarks.  The 
Bookmarks tab toolbar contains the following icons:  Delete Selected 
Bookmarks, New Bookmark, Expand Current Bookmark and the Options menu.  
Click on the Bookmarks icon located in the Navigation Pane (which is to the left 
of the body of the document). 
 

New Bookmark Options  
 

 
 
 
Create Bookmarks 
 

1. Open the Navigation Pane by clicking on the View pull-down menu, 
select Navigation Panels and click on Show Navigation Pane. 

2. Click on the Bookmarks icon to show the bookmarks. 
3. Click the bookmark above the place where you want a new bookmark 

to appear.  If you do not specify a place for the new bookmark, it is 
added to the bottom of the list. 

4. Click the New Bookmark button or click on the Options button and 
select New Bookmark.  The default name of the Bookmark is Untitled, 
enter a new name for the bookmark and press enter.  Remember to 
choose a name for the bookmark that accurately describes the 
contents of the bookmark. 

Delete Bookmarks 

Bookmarks Icon 

Expand Current Bookmark 
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5. Using the Hand tool click in the document where you want the 
bookmark to link. 

6. Right click on the bookmark and select Set Destination.  A window 
will pop up asking you if you are sure you want to set the destination 
to the new location, click Yes. 

 

 
 

 
Delete Bookmark 
 

1. Click on the bookmark you wish to delete to highlight it then click on 
the Delete icon located in the Bookmarks Tab Toolbar. 

2. Or you can right click on the bookmark you wish to delete and select 
delete from the menu.  See below. 

 

 
 
 
Create Bookmarks from Document Structure 
 
If there were no bookmarks created when your PDF document was created you 
can add them from the document structure.   

1. In the Navigation pane click Bookmarks to open the Bookmarks tab. 
2. Click the Options drop-down menu and select New Bookmarks from 

structure.  A Structure Elements window will open. 
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3. Click a structure element name to select it.  To add additional 
elements hold down the SHIFT key and click to add contiguous 
elements or hold down the CTRL key and click to add noncontiguous 
elements.  To select all the structure elements, click the Select All 
button. 

4. Click Ok, and Acrobat creates a bookmark for each selected structure 
element located.  The bookmark is untitled and nested in tree 
fashion.  Click the plus sign to expand the bookmarks. 

 

 
 
 
 
Arrange Bookmarks 

 
Acrobat nests bookmarks when you use the New Bookmarks From Structure 
command.  You can create your own bookmark nests to organize a cluttered 
Bookmarks tab. 
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1. Select the bookmark(s) you want to nest.  You can select contiguous 
(SHIFT-click) or noncontiguous (CTRL-click) bookmarks. 

2. Click and drag the bookmarks toward the bookmark under which you 
want them to nest.  The mouse changes to a right-pointing arrowhead 
with a dotted line as you drag the bookmarks. 

 

 

Line indicates where the bookmarks will 
reside. 

 
3. Notice how the bookmarks are now linked to Nested bookmarks.  If 

you click on the minus sign next to Nested bookmarks the tree will 
collapse. 
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Working with Thumbnails 
 
Thumbnails are miniature images of each page in a PDF document.  These 
thumbnails can be used to navigate, edit, insert, delete and reorder your 
pages.   To view a document’s thumbnails click on the Pages icon on the 
Navigation Pane. 
 

 
 
Insert Pages 
 

1. To insert a page into your PDF document click a thumbnail to select 
the page before or after the place where the new pages will be 
inserted. 

2. Choose Insert Pages from the Pages tab Options menu to open the 
Select File To Insert dialog box.  You can insert any file type 
supported by Acrobat.  If the document you select is not a PDF 
document, it is converted to PDF and added as a page. 
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3. Click the Files of type drop-down arrow and select the type of 
document to insert. 

4. Select the file or files you want to insert and click Select to open the 
Insert Pages dialog box. 
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5. From the Location drop-down menu, choose Before or After. 
6. In the pages section, select the page where you want the document 

inserted.  You can insert the document before or after the first page, 
last page or currently selected page in the PDF document. 

7. Click Ok and Acrobat inserts the selected documents in the location 
specified and creates a thumbnail for each new page. 

 
Delete Pages 
 

1. To delete a single page, click the thumbnail and then click the Delete 
Selected Pages button  .  A warning dialog box will appear, click Ok 
to delete the page or click Cancel to stop the operation. 

2. To delete contiguous pages click a thumbnail then hold down the 
SHIFT key and click contiguous thumbnails to add them to the 
selection.  When you are finished selecting click on the Delete 
Selected Pages button and click OK in the warning dialog box. 

3. Another way you can delete contiguous thumbnails is after selecting 
the thumbnails for deletion click on the Options menu button select 
Delete Pages, a Delete Pages dialog box opens.  Click the From radio 
button to change the pages that you would like to delete.  Enter the 
first and last page to be deleted. Click OK. 

 

 
 

4. To delete noncontiguous pages, click a thumbnail then hold down the 
CTRL key and click additional thumbnails to add them to the 
selection.  When you are finished selecting click on the Delete 
Selected Pages button and click OK in the warning dialog box. 

 
Reorder Document Pages 
 
You can use thumbnails to change the order in which pages appear in a PDF 
document.  This can be accomplished by dragging-and-dropping. 
 

1. Open the Pages tab and select the thumbnail that represents the page 
you want to move.  You can move more than one page at a time by 
selecting contiguous or noncontiguous thumbnails, as discussed in 
the previous section. 
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Note:  You can view several thumbnails at once by clicking on the 
Options menu and selecting Reduce Page Thumbnails from the list.  
To enlarge the view, select Enlarge Page Thumbnails from the Options 
menu list. 

 
2. Drag the selected thumbnail to the desired location.  The cursor 

changes to a filled arrow with an attached document and a solid blue 
line appears to indicate the current position of the thumbnail. 

 

 

Current position of thumbnail 

 
3. Release the mouse button when the solid blue line appears, this 

indicates the new location.  Acrobat automatically renumbers the 
thumbnails. 
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Creating Check Boxes and Text Fields 
 
Acrobat Professional provides you with the necessary tools to create active 
check boxes and writeable text fields in a PDF document.  These tools make it 
easy for you to create basic forms.  You can create your form in any Microsoft 
application, convert it to a PDF and then add boxes and or fields.  Two 
important advantages of using Adobe Professional for forms are that any 
operating system can open the file and users cannot modify the form. 
 
NOTE:  Adobe Acrobat Professional 8 has a feature where you can enable your 
form to allow users to save the document to their hard drive when opened in 
Adobe Free Reader (see Enabling Usage… below Text Fields section).  
 
Check Boxes 
 

1. Open the PDF document. 
2. Go to Tools. 
3. Click on Forms. 
4. Select Show Forms Toolbar. 

 

 
 

5. The Forms Toolbar will appear in the body of the document. 
6. Click on the Check Box tool. 

 

 
 

Check Box tool 
 

7. The cursor changes to a crosshair.  Drag the crosshair to where you 
would like the check box to appear within the document.  

8. Hold down the left mouse button and drag the mouse to create the 
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size of the box.  The box will appear as dotted lines.  When the box is 
the correct size release the left mouse button.  A Check Box 
Properties dialog box will appear. 

 

 
 

9. This window enables you to customize your check box. 
 

- General: this tab allows you to name the check box and set it as a 
read only or required box. 

 
- Appearance: use this tab to set the border color, line thickness, 

font size and text color. 
 

- Options: click on the Check Box Style drop-down list to select 
which graphic will appear in the Check Box when it is selected. 
 

- Actions: the Select Trigger drop-down menu provides a variety of 
options to choose from to trigger the action: 

 
• Mouse Up: the action executes when the mouse button is 

released. 
• Mouse Down: the action occurs when the mouse button is 

pressed. 
• Mouse Enter: the action occurs when the mouse passes 

over the field boundaries. 
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• Mouse Exit: the action executes when the mouse is moved 
beyond the field target area. 

• On Focus: the action occurs when the field is selected 
either through a mouse action or tabbing. 

• On Blur: the action occurs when the field is deselected as a 
result of a mouse action or tabbing. 

 
10. Once you have completed the property selections click Close at the 

bottom of the window.  The box appears red in color, see illustration 
below. 

 
11. Click on the Hand Tool and click in the check box, a check mark will 

appear. 
12. Click the check box again to remove the check mark. 

 
13. If changes need to be made to existing boxes open the Show Forms 

Toolbar and select the Check Box tool.  Make changes by right 
clicking on the box and selecting Properties from the menu. 

14. If you would like to delete a box right click on the box, rest the 
mouse on edit and click on delete. 

 
Text Fields 
 

1. Follow steps 1 through 5 as discussed above. 
2. On the Forms Toolbar select the Text Field tool. 

 

 
 
 Text Field Tool

 
3. The cursor changes to a crosshair.  Drag the crosshair to where you 

would like the text field box to appear within the document. 
4. Hold down the left mouse button and drag the mouse to create the 

size of the box.  The box will appear as dotted lines.  When the box is 
the correct size release the left mouse button.  A Text Field Box 
Properties dialog box will appear. 
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5. This window enables you to customize your text field box. 
 

- General: this tab allows you to name the text field box and set it as 
a read only or required box. 

 
- Appearance: use this tab to set the border color, line thickness, 

font size and text color. 
 

- Options: within this tab you can set the text alignment, select how 
the text will appear within the box and set the spell checker (this is 
set as the default). 

 
- Actions: the Select Trigger drop-down menu provides a variety of 

options to choose from to trigger the action. 
 

6. Click on the Hand Tool, click in the text field box, the box is now 
active. 

7. If changes need to be made to existing boxes open the Show Forms 
Toolbar and select the Text Field tool.  Make changes by right clicking 
on the box and selecting Properties from the menu. 

8. If you would like to delete a box right click on the box, rest the 
mouse on edit and click on delete. 
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Below is an example of a PDF document with writable text fields and check 
boxes. 
 
 

 
 
 
 
Enabling Usage Rights in Adobe Reader 
 
Adobe Acrobat Professional 8 has a feature where you can enable your form to 
allow users to save the document to their hard drive when opened in Adobe 
Free Reader. 
 

1. In an open PDF file click on the Advanced pull down menu and select 
Enable Usage Rights in Adobe Reader.  The following window will 
appear.  This window explains the functions of this option.  Click Save 
Now. 
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2. A Save As window opens.  Name the file and click Save.  A good rule 
of thumb is to give the file a different name so that you can 
distinguish between the enabled file and the original file.  The reason 
for this is for tracking form purposes.   
 

3. Now when you send the form the recipient can fill it in and save it to 
their hard drive. 
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